
AJA KONA、Io および T-TAP™ ソフトウェアインス
トーラー 
リリースノート - macOS v14.3 

重要な記載事項 - 必ずお読みください 

対応 OS 
このソフトウェアおよびドライババージョンは、macOS 10.14 (Mojave), 10.13.x (High Sierra)、
macOS 10.12.x (Sierra) と互換性があります。上記以前の macOS バージョンでは継続して動作はす
る場合はありますが、動作テストおよび正式なサポートの対象外となります。4K/UHD や 60p といっ
たハイフレームレートを用いるワークフローが必要な場合には、macOS 10.14 (Mojave) または
10.13.x (High Sierra) のご利用をお勧めします。 

その他のハードウェアについての推奨事項や必要事項 * については、下記リンクを参照ください。 
　https://www.aja.com/support/kona-system-configuration 

また、下記リンクの AJA Thunderbolt ソリューションページでは、すぐに導入いただけるようケーブ
ルの仕様を含めた詳細情報をご紹介しています。 
　https://www.aja-jp.com/solutions/thunderbolt 

*注：本リリースノート末尾の ”既知の問題と制限事項” の項目をご確認ください。”macOS High 
Sierra でのインストール時の重要な情報” 項目では、High Sierra 以降の macOS で最初にインストー
ルする際の、ハードウェア認識におけるセキュリティの問題について記載があります。 

          

ソフトウェア 
以下の AJA ソフトウェアバージョンは、本インストーラーと合わせてご使用ください： 
 AJA Control Room v14.3、Control Panel v14.3、System Test v14.3 

このインストーラーは、下記のサードパーティ製ソフトウェアバージョンと互換性があります。ベスト
なパフォーマンスを求める場合には、最新版のご使用をお勧めします。 
*なお、いくつかのソフトウェア開発元では古いバージョンの macOS には対応しない場合がありま
す。そのため、AJA インストーラーパッケージではその OS バージョンに対応しているもののソフ
トウェア開発元ではその OS への対応が終了している場合には、AJA 側ではサポートやトラブル
シューティングを行うことはできません。 
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 Adobe 
 • Premiere Pro CC 2019*、2018、2017　　　　　　　 
 • After Effects CC 2019*、2018、2017 
 • Photoshop CC 2019*、2018、2017 
 • Prelude CC 2019*、2018、2017 
 • Audition CC 2019*、2018、2017 
　  
 Apple 
 • Final Cut Pro X - 10.4.x*、10.3.2、10.3.1、10.3、10.2.3 

Avid 
 • Media Composer - 2018.x*、8.10、8.9、8.8、8.7、8.6、8.5、8.4 

 Telestream 
 • Wirecast - 10.x、9.x、8.x、7.x、6.x 

 その他の互換アプリケーション ** 
 • http://www.aja-jp.com/products/kona#ソフトウェア対応表 
 • http://www.aja-jp.com/products/io#ソフトウェア対応表 

** その他のアプリケーションで使用するために必要な AJA ドライババージョンの詳細については、各ソフト
ウェアメーカーにお問い合わせください。 

v14.3 での新機能 

• AJA KONA IP （受信および送信）SMPTE ST 2110 対応 (最大 2K/HD 60p まで） 

• AJA Io 4K Plus において、Telestream Wirecast* 使用時に 6G-SDI を有効な インプット/アウトプッ
トとして追加（AJA MultiChannel Config 4K 設定） 
注記：Wirecast の設定は、AJA Multi-channel Config 経由で行います (AJA Control Panel ではご
ざいません) 

v14.3 での推奨事項 

• Avid Media Composer または AJA Control Room でのキャプチャー時には、最適な結果が得られる
ように “Ref In” を “Video In” に設定することをお勧めします。(AJA KONA、AJA Io 製品および Avid 
DNxIV、DNxIP） 
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v14.3 での修正点、変更点および改善点 

注記: 
下記の事項は、主に影響のある AJA 製品がまとめて記載されています。特別に記載のない他の AJA 製品で
あっても同じ症状が影響していた場合もありますので、もし特定の修正内容を探している場合は、全ての記載
を確認頂くことをお勧めします。 

• QuickTime コンポーネントは現在使われなくなり、AJA デスクトップウェアパッケージからも削除さ
れておりますので、デフォルトではインストールされなくなりました。まだ QuickTime コンポーネン
トを保持しインストールされたい場合には、AJA 製品ページ（英語版）の “Support” メニュー内 
“Software Archive” 欄よりダウンロードすることが可能です。 
• AJA Control Room においては、アプリケーション内で QuickTime ライブラリが保持できるよ
うになったため、これまで使われていた QuickTime コンポーネントとの従属関係はなくなりました。

• AJA ハードウェアを使用している最新のサードパーティ製ノンリニア編集ソフトおよびその他のア
プリケーションでは、これまで使われていた QuickTime コンポーネントとの従属関係はなくなって
いるはずです。より詳細な情報が必要な場合は、各ソフトウェア開発元にお問い合わせください。 

• Mac 版 AJA Control Panel において、VANC checkbox は現在使われなくなり削除されました。こ
の機能は、FCP 7 および AJA VTR Xchange 向けの機能でした。 

• AJA KONA HDMI 使用時に AJA Control Panel において、多くの Canon 製カメラからの入力ソー
スが誤って YUV 4:4:4 と認識されてしまう不具合を修正 

• AJA KONA HDMI 使用時に AJA Control Panel において、いくつかの Panasonic 製カメラからの
ソースを違うインプットに入れ替えた際に、信号が検出されるまでに最大 20 秒かかってしまう不具合
を修正 

• AJA KONA HDMI 使用時に AJA Control Panel において、いくつかの Panasonic 製カメラからの
ソースが input 1 および 2 において誤って DVI (RGB 8 bit）と認識されてしまう不具合を修正 

• AJA KONA HDMI 使用時に AJA Control Panel において、KONA 4 の HDMI 出力からの信号が 
input 3 および 4 において誤って DVI (RGB 8 bit）と認識されてしまう不具合を修正 

• AJA KONA HDMI 使用時に AJA Control Panel において、Control Panel 内の各 input を右クリッ
クするとインプットオプションのウィンドウが開くが、設定したインプット変更が反映されない不具合
を修正 

• AJA KONA HDMI 使用時に AJA Control Panel において、4K/UHD プレイバック時にアプリケー
ションが落ちてしまう不具合を修正 

• AJA KONA HDMI、Io 4K Plus および Io 4K 使用時に AJA Control Panel において、MacBook 
Pro からの HDMI ソースがインプットとしてうまくロックされない不具合を修正 
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• AJA KONA 1 使用時に AJA Control Panel において、ソースフォーマットが変更された際に 
“Follow Input” (入力信号に準ずる）機能が正しく動作しない不具合を修正 

• AJA KONA IP、KONA 4 および Io 4K 使用時に AJA Control Panel において、”Info” タブが 
bitfile を “bad bitfile type” と報告する不具合を修正 

• AJA Io 4K Plus、Io 4K、KONA 4、KONA IP、Io IP、Avid DNxIV および  Avid Io IP 使用時に 
Telestream Wirecast において、選択した内容に関わらずオーディオ入力は SDI 1 入力が常にデフォ
ル設定になってしまう不具合を修正 

• AJA KONA または Io 製品使用時に Telestream Wirecast において、ショットが選択されていない場
合にオーディオ入力（パススルー）が存在し、アプリケーション立ち上げ時にアナログ/ヘッドフォン/
SDI モニタリング/HDMI 出力での音声がミュートされない不具合を修正 

• AJA KONA または Io 製品使用時に Apple FCPX において、プレイバック時に冒頭でコマ落ちが発生
することがある不具合を修正 

• AJA Io 4K Plus、Io 4K、Io XT、KONA 4 および KONA LHi 使用時に Apple FCPX において、
プレイバック停止時に音声が断続的に繰り返されることがある不具合を修正 

• Adobe Premiere Pro CC 使用時にキャプチャーウィンドウを開いている際に、AJA KONA または 
Io 製品で入力ビデオフォーマットが変更されるとアプリケーションもしくはホストシステム全体が落ち
てしまう可能性がある不具合を修正 

• Adobe Premiere Pro CC 使用時に、AJA KONA または Io 製品でキャプチャーされたもしくは取り
込まれたソースからハイフレームレート素材をプレイバックすると、コマ落ちが発生する不具合を修正 

• Avid Media Composer 使用時に AJA KONA または Io 製品 および/または Avid DNxIV および 
Avid DNxIP において、スクラブを伴って再生し始めた際に前の方へ飛んだあと戻るような挙動が生じ
る不具合を修正 

• Avid Media Composer 使用時に、 AJA KONA または Io 製品 および/または Avid DNxIV および 
Avid DNxIP へ SDI 入力が接続されているとアプリケーションが立ち上がらない不具合を修正 

• Avid Media Composer 使用時に、 AJA Io 4K Plus、Io IP、Avid DNxIV および Avid DNxIP で
キャプチャー開始時に崩れたフレームが入る不具合を修正 

• AJA Control Room または Avid Media Composer 使用時に AJA KONA または Io 製品 において、
リファレンスを “Video In” に設定しているとキャプチャーまたはプレイバックの開始が遅くなる症状を
改善 

• Io XT 使用時に、アナログオーディオ出力が高周波数では位相ずれを起こしていた不具合を修正 
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• Io XT (UFC ファームウェア）使用時に、セカンダリーのダウンコンバートされた出力を適用できない
不具合を修正 

以前のリリースでの修正点および改善点 

注記: 
下記の事項は、主に影響のある AJA 製品がまとめて記載されています。特別に記載のない他の AJA 製品で
あっても同じ症状が影響していた場合もありますので、もし特定の修正内容を探している場合は、全ての記載
を確認頂くことをお勧めします。 

v14.2.1 
• SMPTE 2022-6/7 対応 Avid DNxIP (Avid 社の Thunderbolt 3 対応新製品）への最終対応版 
•
• Avid DNxIV および Avid DNxIP において、アナログオーディオ設定項目を拡張 
• AJA  Control Panel では、以下 4 つのモードが選択可能に： 
• “8 in” ： A1-8 までを 8 チャンネル入力として設定 
• “8 out”：A1-8 までを 8 チャンネル出力として設定 
• “4 in, 4 out”：A1-4 までを 4 チャンネル入力として、A5-8 までを 4 チャンネル出力として設定 
• “4 out, 4 in”：A1-4 までを 4 チャンネル出力として、A5-8 までを 4 チャンネル入力として設定 

• KONA LHi および KONA LHe Plus において、SDI 出力時の不具合を修正 

• KONA HDMI において、AJA Control Room を用いて HDMI ポート 3 および 4 から Deep Color 
（ディープカラー）をキャプチャーした際に音声が欠ける不具合を修正 

v14.2 
• AJA KONA HDMI 対応（AJA PCIe カード新製品） 
• AJA KONA 1 対応（AJA PCIe カード新製品） 
• AJA Io IP 対応（AJA Thunderbolt 3 対応新製品） 

• AJA Control Panel 上の “Deep Buffer” 設定により、AJA Control Room を用いたインジェスト中に
ストレージ（記憶装置）が遮断した際の対処を改善 
• 下記の設定で、インジェスト中に書き込み先のメディアを保護するためにキャッシュ用の RAM を
割り当てることが可能になりました： 
• AJA Control Room: Preferences > Capture > “Reserve buffer size for deep capture 
queues” 

• Io 4K Plus、Avid DNxIV、Io IP および Avid DNxIP において、アナログオーディオ設定項目を拡張 
• AJA  Control Panel では、以下 4 つのモードが選択可能に： 
• “8 in” ： A1-8 までを 8 チャンネル入力として設定 
• “8 out”：A1-8 までを 8 チャンネル出力として設定 
• “4 in, 4 out”：A1-4 までを 4 チャンネル入力として、A5-8 までを 4 チャンネル出力として設定 
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• “4 out, 4 in”：A1-4 までを 4 チャンネル出力として、A5-8 までを 4 チャンネル入力として設定 

• Adobe Premiere Pro CC 2017 以降において、 “Disable creation of SCC/MCC files from Closed 
Caption data” オプションが追加され、CC データを含む信号をキャプチャーする際に SCC/MCC ク
ローズドキャプション (CC) ファイルの自動生成を防ぐことが可能に： 

Adobe Premiere Premiere Pro CC > Window > Capture > Settings > Edit > Settings > 
“Disable creation of SCC/MCC files from Closed Caption data”. 

• 注：このオプションは、デフォルトではオンになっていないため、古いプロジェクトでは有効になっ
ていない可能性があります。 
• 注：この機能を有効にしても、収録メディアにクローズドキャプションデータをエンコードさせない
ようにはできません。ソース信号の中にデータが存在する場合には、キャプチャーされたメディアに
そのデータは保持されます。 

• 重要な更新事項については、本リリースノート末尾の ”既知の問題と制限事項” の項目にも追記されてい
ます。macOS High Sierra 以降の macOS で最初にインストールする際の、ハードウェア認識におけ
るセキュリティの問題についての記載事項を参照ください。 

• Adobe Premiere Pro CC において、ProRes 422、ProRes HQ または DNxHR HQX でのキャプ
チャー時に、（キャプチャーされたファイルには全てのフレームが含まれているにも関わらず）コマ落
ちしたフレームをキャンバスが表示しているように見える問題を修正 

• Adobe Premiere Pro CC において、ProRes 4444 をキャプチャー設定した場合に、非圧縮 BGRA 
クリップがディスクに書き込まれてしまう問題を修正 

• Adobe Premiere Pro CC において、RGBA をキャプチャー設定で選択した場合に、ブラッククリップ
がディスクに書き込まれてしまう問題を修正 

• Adobe Premiere Pro CC において、（最初に新しいプロジェクトで）AJA クリップからシーケンスを
自動生成する際に、30 秒以上時間がかかったりアプリケーションがクラッシュしてしまう症状を修正 

• Adobe Premiere Pro CC において、両方のフィールドを表示する際に、キャンバス上での SD ビデオ
再生の質が悪くなる症状とAJA デバイスからのビデオ出力が欠ける症状を改善 

• AJA Control Room において、キャプチャー時にアプリケーションを中止もしくは終了するかどうかを
確認するダイアログを表示するよう改善 

• AJA Control Panel において、実際はプレイバックをしている時に、インプット・パススルーにチェッ
クが入っているように見える、またその逆のような、誤った画面表示を修正 

• AJA Control Panel において、23.98 でフラグが立てられている P2/MXF の 480i 29.97 素材が示さ
れた場合に、フレームバッファおよび出力が正しく 525i 29.97 に設定されるよう修正 

• AJA Control Room において、Open GL アクセラレーションを利用していない場合、プレイバック時
にビューワ画面で SD 素材のフレーム下部にブラックが表示されていた問題を改善 
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• T-TAP からの出力映像が水平方向にシフトしてしまう不具合を修正 

• Adobe Premiere Pro CC のキャプチャーツールの挙動を修正。例えば、T-TAP からキャプチャーしよ
うとしてもできないなど（T-TAP はモニタリング専用デバイスです） 

• Telestream Wirecast アプリケーションを中止/終了した際に、T-TAP が通常にはない設定を残し、
AJA Control Panel 上で “In use by OEM application” と表示される不具合を修正 

• T-TAP では AJA Control Panel において、Timecode タブをクリックするとアプリケーションがクラッ
シュする問題を修正 

• Io 4K Plus および Avid DNxIV において、電源が入った状態の HDMI モニターに AJA デバイスを接続
し、その後 AJA デバイスの電源を入れた際に生じる HDMI 表示とキャプチャーの不具合を修正 

• Io 4K Plus および Avid DNxIV において、Avid Media Composer でのオーディオパンチイン使用時
に、モードを変更したり再生ヘッドを移動した際に（入ってくる）スルーされたモニタリング用のオー
ディオが欠落することがある症状を修正。この症状はモニタリングに対してのみ影響があり、キャプ
チャーされたオーディオにはボイスオーバーの内容は収録されています。 

• Io 4K Plus および Avid DNxIV において、AJA  Control Panel 上で  4K クアッド入力（スクエアディ
ヴィジョン）に設定されている際に、Thunderbolt 3 ケーブルを抜くと、場合によってはカーネルパニッ
クが生じる不具合を修正 

• Io 4K Plus および Avid DNxIV において、AJA  Control Panel において、SDI 3 と SDI 4 をビデオと
キーに設定した場合に、誤って SDI 5 がビデオとキーとして表示されるフィードバックを修正 

• Io 4K Plus および Avid DNxIV において、AJA  Control Panel 上でフレームバッファを YCbCr に、
HDMI カラースペースを 10bit YUV に設定した場合に、HDMI 出力でバンディング（横縞のグラデー
ションノイズ）が発生する不具合を修正 

• Io 4K Plus および Avid DNxIV において、HDR メニューでオンはできるが完全にはオフされない問題
を修正 

• Io 4K Plus および Avid DNxIV において、ボリュームノブの操作時に聞こえるタッピング音を修正 

• Io 4K において、AJA  Control Panel でクアッド（スクエアディビジョン）SDI 入力に設定した際に 
HDMI 出力がグリーンがかった色味になり、HDMI ウィジェットが 2K/HD へのダウンコンバートの代
わりに 4K/UHD をパススルーしている表記になっている不具合を修正 

• Io 4K において、Adobe Premiere で 2K フォーマットをプレイバックする際に、AJA  Control 
Panel ではフレームバッファが UHD に設定されてしまう問題を修正 

• Io 4K および Io XT において、AJA  Control Panel を立ち上げた際に、カラーバーの代わりに不要な
映像が表示される不具合を修正 
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• Io 4K Plus、Avid DNxIV、Io 4K および KONA 4 において、AJA  Control Panel のフレームバッファ
で RGB-10 (または ARGB-8/RGB-12）に設定し、カラースペースを 10-bit YCbCr / 4:2:0 に設定し
ようとすると、HDMI が出力されなくなる不具合を修正 

• Io 4K Plus、Avid DNxIV、Io 4K および KONA 4 において、AJA Control Room での SDI RGB 入力
時に異なるカラースペースと収差が表示される不具合を修正 

• Io 4K、Io XT および KONA LHi において、AJA  Control Panel で 2K を選択している場合に HD、
4K を選択している場合に UHD が代わりに出力されてしまう不具合を修正 

• KONA LHi および Io Express において、Control Panel のフレームバッファフォーマットにおいて、
一時的に正しくない解像度や破綻した映像が出力される不具合を修正 

• KONA 4 において、UFC モードのファームウェアを利用して Wirecast を動作した場合に起こるオーディ
オ品質の問題を修正 

• KONA IP において、SMPTE 2022-6/7 ファームウェア使用時に、送信側の KONA IP でビデオ出力
（AJA  Control Panel 内で）をマニュアルで無効にし、その後再度有効にした場合に、受信側の 
KONA IP がそれを受けてビデオストリームを再構築するよう修正 

• KONA IP において、SMPTE 2022 ファームウェアおよび JPEG 2000 ファームウェア使用時の、2K 
フォーマット（最大 30p まで）の送信（プレイバック）および受信（インジェスト）に関する問題を修
正 

• KONA IP において、AJA Control Panel では、SMPTE 2022-6/7 ファームウェア使用時に 2K フォー
マットから SD フォーマットに切り替えると、送信（プレイバック）が中断されることがある不具合を
修正 

• KONA LHi において、ビデオ入力時にフレームバッファを HDMI 入力または SDI 入力をソースとして
選択（そして入力ソースに合わせてフレームバッファのフォーマットを設定）して使用する際に、ダウ
ンストリームキーヤーで HDMI 出力および SDI 出力において一時的にブラックフレームが表示される
不具合を修正 

• KONA LHi において、ビデオ入力時にフレームバッファを HDMI 入力をソースとして選択して使用する
際に、ダウンストリームキーヤーで入力信号にロックしてしまう不具合を修正 

• KONA LHe Plus と Wirecast の組み合わせで使用する際に、ビデオ出力を見失う不具合を修正 

　v14.0.2 
• Io 4K Plus および Avid DNxIV において、ファンスピード制御を改善 

• Avid DNxIV でのマイク入力時において、ゲインノブのジグザグ音を除去 
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　v14.0.1 

• Io 4K Plus および Avid DNxIV において、HDMI オーディオ Ch 3/4 のスワップ機能を追加 

• Io 4K Plus、Io 4K、KONA 4 および Avid DNxIV において、SDI クアッド入力/出力のスワップ機能を
追加 

• HDMI 出力のタイミングおよび安定性を全般的に修正（特に HDMI 1.4 モニターへの対応を改善） 

• macOS での、KONA 4 からの HDMI 出力における不具合を修正 

• 2SI （ツーサンプルインターリーブ）での UltraHD フォーマット HDMI 出力における不具合を修正 

• HDMI を入力ソースとした場合に、入力信号の認識が一時的に止まる不具合を修正 

• 4K 出力の際に SDI 3 からの出力が欠けている不具合を修正 

• SD 出力時のクローズドキャプションの不具合を修正 

•  Control Panel 上でのインプット・パススルー画面で、挙動を正しく表示するよう修正（HDMI ダウン
コンバート時） 

•  Control Panel 上で、接続された機器が Io 4K Plus とも Avid DNxIV とも表示されてしまう不具合を
修正 

• AJA Multi-Channel Config がウイルスチェックソフトウェアと干渉する不具合を修正 

• macOS および Windows インストーラーで Python モデルを使用できるよう改善 

• キャプチャー中に、AJA Control Room 上でリップシンクずれのエラーメッセージが表示されてしまう
不具合を修正（キャプチャー動作自体には問題はありません） 

• キャプチャー中に、Adobe Premiere Pro 上でリップシンクずれのエラーメッセージが表示され、キャ
プチャー結果では同期が外れてしまっている不具合を修正 

• Avid Media Composer で、プレイバック開始時にスナップバックが一時的に止まる不具合を修正 

• Avid Media Composer で、P/PsF 切り替え時の反応を改善（このバージョンでは即座に反応するよう
になっています） 

    v14.0 
• AJA  Control Panel へオーディオミキサーを追加 

• スリープモードからの復帰時に Apple FCPX の再起動が必要になる不具合を修正 
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• Apple FCPX でのタイムコード出力の信頼性を改善 

• Apple FCPX が起動中、AJA  Control Panel で HDR 設定を変更した際に、変更内容を認識するため
にアプリケーションの再起動が必要になる不具合を修正 

• Apple FCPX において、スリープ＞起動＞立ち上げサイクル後のカーネルパニックを修正 

• Apple FCPX において、Thunderbolt プラグサイクル上で “Ioclasscount for AudioStream” がゼロ
にリセットされない不具合を修正 

• Adobe Premiere Pro CC において、インターレース素材の逆再生時にフィールドが正しく入れ替えら
れていない部分を修正 

• Adobe Premiere Pro CC において、アイコンをスクラブし、ビンからクリップをキューする際、1回
目の再生時に生じる停止フレームの不具合を修正 

• Adobe Premiere Pro CCでビデオディレイがゼロを超えて設定されている時に再生がジャンプする問
題を修正 

• Adobe Premiere Pro CC において、ソースビューワーからの RP188 出力を修正 

• Avid Media Composer において、2K 60p プロジェクトでのプレイバック時の不具合を修正 

• Avid Media Composer において、AMA (Avid Media Access）でリンクされた P2 AVC-Intra 再生
時の深刻なフレーム落ちおよび A/V 同期ずれを修正 

• T-TAP を Wirecast から取り出す際に OEM モードのデバイスを接続したままにしてしまう不具合を修
正 

• 機器を接続せずに AJA Control Panel を立ち上げた場合、アプリケーションが意図せずに終了してし
まう不具合を修正 

• AJA Control Panel において、macOS では操作不可能なコンテキストメニューを修正 

• AJA Control Room において、Batch Capture ビン画面に VTR オンライン/オフラインアイコンを追
加 

• AJA Control Room において、バッチキャプチャー時 ”OK” をクリックした際に、デバイスオフライン
のダイアログが表示されず、ループしてしまう不具合を修正 

• AJA Control Room において、ビデオオプションを “no video” に設定した際、現在地点のタイムコー
ドが更新されなくなる不具合を修正 

• AJA Control Room において、DPX Cineon ヘッダーシークエンスのプレイバックでのタイムコード不
具合を修正 
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• AJA Control Room において、DVCProHD を “on the fly” （即時）でキャプチャーする際、実際にキャ
プチャーが開始されるまでに 1 秒遅れる不具合を修正 

• AJA Control Room において、圧縮コーデックプルダウンメニューをカテゴリー分け 

• 接続されている下流の Thunderbolt 機器で 2 回目のスリープ状態の後に、AJA デバイスへ正常に接続
できない不具合を修正 

• Mac がスリープから起動した後に AJA Thunderbolt 機器が認識されなくなる不具合を修正 

• アルファチャンネル付きの ProRes 4K 4444 クリップ の使用時に AJA デバイスを正確にセットアップ
できない不具合を修正 

• AJA Desktop uninstaller の名前を変更 

• T-TAP において、720p VariCam プレイバックが途切れ途切れになる不具合を修正 

• KONA 4, Io 4K, Io 4K Plus および Avid DNxIV においてスクエアディヴィジョン使用時のみ、クアッ
ドリンク SDI 入力ソースは HDMI 出力では UltraHD として認識することができなくなっています。そ
の代わりに、 HDMI 出力は HD モニタリングとしてダウンコンバートされるようになります。 
• 注記：この制限は、2 サンプルインターリーブ（2SI）入力ソースには適用されません。2 サンプル
インターリーブ (2SI) 使用時には、クアッドリンク SDI 入力ソースは HDMI 出力において UHD と
してモニタリングすることができます。 

• KONA 4、Io 4K および Io 4K Plus では、ハイフレームレート非対応のモニターで HDMI プレイバッ
クを容易にするために、ハイフレームレート素材の信号を間引くことはできなくなりました。 

    v13.0 
• Adobe Premiere Pro CC でのループ再生時にビデオがフリーズしてしまう不具合を修正 

• Adobe Premiere Pro CC で RGBA 8 ビットをキャプチャーすると不完全なビデオになってしまう不
具合を修正 

• Adobe After Effects 向けの AJA プラグインが Adobe Premiere Pro CC がインストールされていな
い場合でもインストールされるように改善 

• Adobe Premiere Pro CC でのキャプチャー画面を開いた状態でメモリー・リークが起こる不具合を修
正 

• Control Room でキャプチャーされた MXF ファイルが、Avid Media Composer とリンクできない不
具合を修正 （File > Import > Link to media) 
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• AJA Control Room で新しいファイルで上書きしようとする際、クリップが重複してしまう不具合を修
正 

• AJA Control Room GUI で、入力機器が接続されていない場合に問題があった、キャプチャー/プレイ
バック画面の不具合を修正 

• AJA Control Room で編集のイン点 ( In Point ) を見失う不具合を修正（”go to IN” 以降でコマ送りし
ながら往復している状態） 

• AJA Control Room でインポートされた Apple ProRes クリップが正しく認識されるように修正 

• ThunderboltTM のプラグアンドプレイ性能の向上 

• DF RP188 キャプチャー時のタイムコード検知を修正（ドロップフレームがノンドロップフレームと検
知されていました） 

•  Io 4K および KONA 4 において、 SDI 4 出力に水平ノイズが発生する不具合を修正 

• UHD テストパターンを修正 

• ETT (Edit To Tape) の不具合を修正（DVCPro HD クリップが読み込まれている場合、ビデオ入力に
歪みが発生） 

• AMD グラフィックカードとの互換性を向上 

• DVCPro HD ルーティングの不具合を修正（DVCPro HD 再生に問題があります） 

• AJA Io 4K での、HDMI 入力時に不完全なビデオが生成される不具合を修正 

• AJA KONA LHi でのアナログ入力をリファレンスとして選択している場合に、 HDMI 入力がリファレ
ンスソースとして置き換わってしまう不具合を修正 

• Level B の処理を改善（AJA デバイスへの入力時） 

• AJA desktop ソフトウェアをアンインストールする際に生じる、AJA desktop ソフトウェアと 
Blackmagic Design ソフトウェア間の競合を修正 

　v12.5.1 
• KONA LHi でのアナログ入力ビデオソース時のゲンロック選択を修正 

• Adobe Premiere 2017 で 12 ビット HDR カラースペース設定が抜けていた問題を修正 

• 32 ビット整数オーディオでキャプチャーされた QuickTime ファイルが一部のサードパーティアプリケー
ションで再生されない問題を修正 
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• Adobe Premiere での非互換性を防ぐため、MXF から 32 ビットオーディオオプションを削除 

• 全ての KONA および Io デバイスでデュアルリンク接続の VPID 問題を修正 

• Avid Media Composer でキーボードの JKL を素早くタイプすると、オーディオをループしてしまう
問題を修正 

• AJA  Control Panel のテストパターンドロップダウンの列をクリックすると AJA Control Panel がク
ラッシュする問題を修正 

• T-TAP で 2K 23.98 の再生問題を修正  

　v12.5 
• キャプチャー時の DNxHR パフォーマンスを改善 

• Thunderbolt を接続した際の一連の動作を改善 

• RP188 LTC のみがある場合に RP188 VITC が表示される問題を修正 

• SDI 2 のアンシラリー タイムコードが AJA Control Panel に表示されていなかった問題を修正 

• Io XT の AJA Control Panel プリセットで Genlock の状態が正しく保存できなかったり、呼び出され
なかったりする問題を修正 

• Io XT の AJA Control Room で再生ペインを選択したときに、 Ref/LTC が Ref に切り替わってしま
う問題を修正 

• 9ピンをタイムコードソースに設定したタイムコードと、ビデオ間のキャプチャー固定オフセットの問題
を修正 

• あるアプリケーションから別のアプリケーションへ切り替えたり、あるプラグインインスタンスから別
のプラグインインスタンスに切り替えたりすると、オーディオシステムがクラッシュする問題を修正 

• Io 4K の電源を入れたまま取り外した時にアプリケーションがハングしてしまう問題を修正 

• 多くの不正なVPID (ビデオペイロード識別子) 問題を修正 

• 4K/UHD の 2SI 入力が KONA 4 と Io 4K で正常にキャプチャーされない問題を修正 

• Control Room のキャプチャークリップが常にノンドロップタイムコードになってしまう問題を修正 

• スリープ状態から復帰した後に出力が不良になる問題を修正 
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• AJA Control Panel の全ての “425” 文字列を 4K と UHD を伝送する方式 2サンプルインターリーブ
を示す ”2-SI” に変更 

• Adobe 再生環境設定を変更した後、Premiere Pro で AJA 出力が行えなくなる問題を修正 

• Premiere Pro のキャプチャーでステレオオーディオを選択しても、ディスクリートモノラルトラックで
ファイルが作成される問題を修正 

• アプリケーションを終了すると HDMI オーディオ出力が常に8チャンネルにリセットされる問題を修正 

• Premiere Pro でタイムラインからタイムライン、またはタイムラインからソースモニタに切り替える際、
AJA 出力で古いビデオフレームが点滅する問題を修正 

• Wirecast 出力のオーディオスタッターによる問題を修正 

• Wirecast で記録されたファイルとライブストリームで作成されたバックグランドノイズの問題を修正 

  v12.4.1 
• AJA ドライバーが原因で AJA ハードウェアのシリアルナンバーを正しく読み込めない問題を修正 

    v12.4.0 
• Premiere Pro で Mercury Playback Engine の設定が GPU 高速処理になっていない場合に 8-bit YUV
設定の再生が不正になる問題を修正 

• AJA デバイスが Mac OS でシステムオーディオデバイスとして選択されている場合に Premiere Pro 
の再生環境で AJA デバイスと Adobe デスクトップオーディオを切り替えると不安定な動作を引き起こ
す問題を修正 

• AJA ドライバーのインストーラーから AJAUncompressedCodec.component を消去 

• Premiere Pro でトリム機能を使用するとビデオ出力がフリーズする問題を修正 

• オーディオハードウェアを使用する方法を変更 

• Mac OS 10.11 で Premiere Pro でのキャプチャー中にフリーズやクラッシュ（または両方）を引き起
こす問題を修正 

• AJA Control Panel が 1080p ハイフレームレート 3G Level B のユーザー設定を保持できない問題を
修正。以前は再起動した後に常に Dual Link 1.5G にリセットされていました。 

• AJA Transmit プラグインで buffer mode を minimum に設定しオーディオのみのファイルを
Premiere Pro のソースモニターで再生するとオーディオが吃る問題を修正 
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• After Effects から他のアプリケーションに切り替えても AJA ハードウェアを離さないレガシーな 
AJA After Effects プレビュープラグイン (Blithook) の問題を修正  

• Adobe After Effects のサポート方法を変更。以前は 2 つの異なるプラグインをインストールしていま
した。“Blithook”プラグインは古いレガシーなプラグインのためデフォルトではインストールされなくな
りました。必要な場合はインストーラーのオプションから選択してください。Transmit プラグインはデ
フォルトのインストールオプションとしてインストールされます。詳しくは Adobe のプラグインマニュ
アルをご確認ください。 

• AJA Control Room で QuickTime ファイル生成時に NCLC カラープロファイルを追加 

• AJA Control Room と Adobe キャプチャープラグインの DNxHR コーデックをアップデート。
DNxHR のキャプチャーパフォーマンスを改善 

• AJA System Test が T-Tap の DMA スピードのテストに失敗する問題を修正 

• AJA ハードウェアが 25fps または 50 fps モードの際に AJA Control Room と Premiere Pro のキャ
プチャープラグインに DV と DVCProHD コーデックが表示されなくなる問題を修正 

• Media Composer が 1080p 50/59.94/60 のプロジェクトを常に 3G SDI Level A モードとして AJA
ハードウェアを切り替えてしまう問題を修正。以前はデュアルリンクと 3G SDI Level B は設定するこ
とが不可能でした。ユーザーは AJA Control Panel でこの設定を選択することができるようになり、
Media Composer を起動する前に設定することで適用されます。 

• AJA Control Room で バッチキャプチャーが失敗する問題を修正 

• AJA Control Room で DNxHR の規則に合わせるために DNxHD の命名規則を変更 

• AJA Control Room で常に バッチキャプチャーで作成したファイルの オーディオが 16 トラックになっ
てしまう問題を修正 

• Io 4K が 10bit HDMI 入力を 8bit として扱ってしまう問題を修正 

• Premiere Pro で DV 圧縮を使用したキャプチャーの問題を修正 

• ホストコンピューターのスリープ後に Io 4K から不正なテストパターンが出力される問題を修正（要
ファームウェアアップデート） 

• AJA Control Room で複数の DNxHD クリップをキャプチャーすると AJA Control Room がクラッ
シュする問題を修正 

• Mac と Windows のインストーラーはデフォルトでレガシーな AJA After Effects プレビュープラグ
インをインストールしないように変更。プラグインはインストーラーの中にはまだ含まれており、イン
ストールするにはカスタムインストールでユーザーが選択する必要があります。この古いプラグインは
高速な伝送速度が不用な場合のみ使用してください。 
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• KONA 3G が SDI 入力 2 からの RP-188 タイムコードを正確に読み込めない問題を修正（要ファーム
ウェアアップデート） 

• AJA Control Room の バッチキャプチャーでキャプチャーを開始した後にアウトポイントの値が変更
されて表示される問題を修正。以前は設定したアウトポイントは正確に実行されていましたが、アウト
ポイントの値が見た目上だけ不正確でした。 

• Avid Media Composer の タイムラインの再生で開始のフレームがまれにスキップされる問題を修正 

• Avid Media Composer の スクラブ後の再生で最初のフレームがまれに不正確なフレームになる問題
を修正 

• Avid Media Composer の ループ再生が原因で exception error を引き起こす問題を修正 

• Premiere Pro のビデオとオーディオのミリセカンドのオフセットによりタイムラインの再生の開始時
にまれにビデオを数フレームスキップする問題を修正 

• AJA Control Room の VTR アウトポイントの表示が バッチキャプチャーの開始後に変更される見た
目上の問題を修正（キャプチャーされたファイルのアウトポイントは正常） 

• KONA LHe+ の AJA Control Panel で AES XLR がオーディオ入力ソースとして選択できない問題を
修正（要ファームウェアアップデート） 

• Io 4K にて AJA Control Panel でのアナログオーディオの設定が正確に反映されない問題を修正 

• Adobe Premiere Pro で 720p フォーマットを元ファイルに正確なフレームでキャプチャーできるよ
うに修正 

• Adobe Premiere Pro のデバイスコントロールプラグインを端数（0.5 単位）のフレームオフセットが
行えるように改善。端数のフレームオフセットは断続的な編集やキャプチャー時にフレーム未満でキャ
プチャーやテープ出力のオフセットを微調整するために使用することができます。 

• Adobe Premiere Pro で RP-188 タイムコードを正しくキャプチャーできるように修正 

• T-Tap と Io Express で Premiere Pro の 正しいビデオフォーマット設定が保持できない問題を修正 

• Io 4K で RGB の HDMI 入力が正しく動作しない問題を修正 

• AJA Control Room の インサート編集でオーディオの最初のフレームが挿入されない問題を修正 

• Adobe Photoshop で AJA インポートプラグインを使用してキャプチャーをした際に、入力された画
像のクロマレベルが低くなる問題を修正 

• 2 サンプルインターリーブ形式の VPIDデータが間違っている問題を修正 
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• Io 4K と KONA 4 の 4K と UltraHD の HDMI 出力におけるバンディングを修正 

• Io 4K と KONA 4 で ダウンストリームキーヤーを使用した際に画像が歪む問題を修正 

• ビデオフォーマットを切り替えることで画像が誤って垂直方向にロックしてしまう問題を修正 

• Premiere Pro の再生設定におけるオーディオとビデオのオフセット設定を修正 

関連製品 

今回の更新で対象となる製品は以下の通りです： 

 
既知の問題と制限事項 

 全般 
• KONA や Io のデバイスを使用時、システムをスリープや休止状態にしないでください。オペレーティ
ングシステム設定で、スリープおよび省電力モードを無効にする必要があります。 

• KONA LHi はオーディオシステムを 1つしか持っていないため、キャプチャーや出力で同時に使用
できるオーディオは 1系統のみに制限されます。同時に複数チャンネルの入力と出力に対応したアプ
リケーションでは、SDI 入力にエンベデッドされたオーディオが使用されますが、HDMI ではオー
ディオを入力できません。入力と出力それぞれが一度に独立した状態で使用される場合（入力から
のパススルー出力ではなく）のみ 1系統のオーディオチャンネルを使用することができます。 

• AJA Control Room と Adobe Premiere CC の MXF OP-1A キャプチャーでは、720p60 , 
1080i30 , 1080p30 , 1080p60 のフォーマットはサポートされていません。 

 macOS High Sierra でのインストール時の重要な情報 
• macOS High Sierra (v10.13) がリリースされ、サードパーティ製のアプリケーション開発者はカー
ネル拡張設定時に識別されることが Apple から求められています。この識別に失敗すると、AJA デ
バイスの使用ができなくなります（非対応の AJA デバイス） 
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• お使いの macOS バージョンおよび AJA デスクトップソフトウェアのインストール履歴によります
が、以下のインストール結果が起こり得ます： 
• macOS Sierra およびそれ以前の対応するバージョン 
• 現行の AJA ソフトウェアのインストールおよびそれ以前の macOS への更新に関しては問
題ありません 

• 以前の macOS から High Sierra へのアップデート 
• すでに macOS Sierra （もしくはそれ以前の OS）においてすでに AJA デスクトップソフ
トウェアパッケージがインストールされている状態で、かつお使いの Mac を High Sierra 
にアプデートする場合には、特に問題は発生しないはずです。信頼された開発者として AJA 
が確認された情報は、以前の macOS から High Sierra macOS へ渡されます。 

• macOS High Sierra で初めて AJA Desktop Software をインストールする場合 
• お使いの Mac が High Sierra macOS で運用されており、初めて AJA デスクトップソフト
ウェアをインストールする場合、インストール中に表示される指示に従って頂ければ、特に
問題は発生しないはずです。(下図：macOS High Sierra のブロックメーセージプロンプト) 

• “OK” をクリックしないでください。その代わりに、”Open Security Preferences” を 
クリックしてください（もしくは システム環境設定 > セキュリティーとプライバシー メニュー
へ）、そして ”Allow (許可）” をクリックして AJA Video Systems 開発者へのブロックを
外してください。（下図：MacOS High Sierra システム環境設定、開発者許可). 
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• 注記：インストールがうまく行っていれば、AJA アンインストーラーを使ってお使いのコン
ピューターから AJA アプリケーションを削除しても開発者の識別情報は macOS High 
Sierra に保持されます。特に問題なく再インストールは実行されるはずです。 

• インストール時の認証エラーからの復旧 
• もしインストール時に “OK” をクリックしてしまい、開発者承認のステップを飛ばしてしまった
場合、AJA デスクトップソフトウェアのインストールは完了にはなりますが、不可欠な拡張イン
ストールは実施されず AJA デバイスは使用可能にはなりません（非対応の AJA デバイス）。 
• Apple はタイムウィンドウを設計しており、部分的なインストール後に遅まきで開発者の承認を
することが可能です。部分的なインストールから 30 分以内であれば、システム環境設定 > セキュ
リティーとプライバシーのメニューでは開発者のメッセージと承認ボタンは有効になっています。
しかし、30 分を過ぎた後ではメッセージもボタンもウィンドウからは削除されています。この
状態から復旧するには、全ての AJA ファイルを（いくつかはマニュアルで）アンインストール
した後、AJA Desktop Software パッケージを再インストールし、AJA Video Systems 開発
者を承認するボタンをクリックする必要があります。  

• 復旧手順 
1. Mac のアプリケーションフォルダ内の AJA Utilities フォルダーにある AJA Uninstaller を実
行します。 

2. 隠し表示になっているユーザーズライブラリ にアクセスします。ライブラリには以下の方法で
アクセスします： 
1. Finder を開きます。 
2. Finder のメニューバーから “Go (移動)” をクリックします。 
3. オプションキーを長押しします。オプションキーが長押しされている間は、ライブラリフォ
ルダが表示されます。 

3. ライブラリ > Preferences を開き、全ての “com.aja.*.*” ファイルを削除します。一つもしく
は複数のファイルがあるはずです。 

4. 置かれている場合は、Dock から AJA Control Panel を削除します。 
5. Mac を再起動します。 
6. AJA デスクトップソフトウェアパッケージをインストールします。 
7. インストールの間に表示されるメッセージでは、”Open Security Preferences” をクリックし
てください（もしくは システム環境設定 > セキュリティーとプライバシー メニューへ）。 

8. 一般タブ内に表示されている AJA Video Systems を承認するボタン（”Allow”）をクリック
してください。このボタンは、30 分間のみ有効です。 

 KONA HDMI 
• 現時点では、チャンネル 1 および 2 ではいくつかの SD ソースは正しく動作しません。SD ソース
をインジェストする際には、チャンネル 3 および/またはチャンネル 4 を使用してください。 

• 現時点では、いくつかの HDMI カメラソースは正しく動作しません。AJA で調査を行いますのでサ
ポートへご連絡ください。 

• 現時点では、音声もキャプチャーする際には音声は聞き取れない仕様になっています。音声はディス
クにキャプチャーされるので、キャプチャー中は音声をモニタリングすることができません。 
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 Wirecast 
• Io 4K や KONA 4 のようなマルチチャンネルのデバイスで構成され、ライブのプログラム出力機能
を使用する場合には始めに入力の設定を構成する必要があります。この場合、マスタークロック
（NTSC もしくは PAL ）をデバイスに設定することになります。そうでない場合、デバイスはデフォ
ルトの 1080i 29.97 に設定され、PAL と NTSC のクロックの混合を引き起こす可能性があります。
必ず Wirecast を起動する前に AJA Multi Channel Config で入力と出力の全てを設定してくださ
い。 

 Adobe Plug-Ins 
• シーケンスとハードウェアのフレームレート設定が異なると、適切なオーディオ出力が得られない場 
合があります。 

- 720p50/59.94/60 以外の 720p フォーマットで発生する可能性があります。 
- この制限を回避するには、Premiere Pro の再生設定で、AJA ビデオデバイスを「Match 
Control Panel」に設定します。その後、AJA  Control Panel を使い、出力に対して1080 
フォーマットへのクロスコンバージョンを設定します。例えば、720p23.98 プロジェクトを
使用する場合は、SDI 出力を選択して 1080PsF23.98 フォーマットを選択し設定します。 

• クラッシュキャプチャーにおいて、RS-422 タイムコードをキャプチャーすることはできません。　　
RS-422 タイムコードに変えてエンベデッドタイムコードを使用することを推奨します。 

• VFR にプルダウンが追加された場合、タイムコードは調整されません。 

• HD-SDI 経由のクラッシュキャプチャーおよびプリントにおいて、 Varicam フレームレートでの動
作は可能ですが、インサート編集やイン点・アウト点を指定してのキャプチャーやバッチキャプ
チャーは行えません。 

• パナソニック社製のデッキにインサート編集を行う際、正しく編集を行えない場合があります。こ
の問題を回避するためには、メニュー項目 202 “ID SEL” が “OTHER” に設定されていることを確
認してください。 

• デッキ制御において 4 秒以下のプリロールは推奨しません。 

• Premiere Pro のモニタ設定のデフォルトは”最初のフィールド”となっています。インターレースを
正しく表示するには”両方のフィールド”を選択してください。 

• Premiere Pro のキャプチャーウィンドウを開いた状態で、デッキのテープが DF から NDF に変更
された場合、DF/NDF ステータスを正しく検知できない場合があります。この時、Premiere Pro 
のキャプチャーウィンドウに表示されるタイムコードは正しくない可能性があります。 

- 同じキャプチャーセッション中に DF と NDF のテープ混在がなければ、この問題はユーザー
に影響しません。 

‣ 対処方法：テープチェンジ時に表示されるダイアログにてテープ名を付与し、 
 OK をクリックする前に新しいテープをスプールしてください。 

‣ 回避方法：キャプチャーウインドウを一度閉じて、再度開きます。 
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• Panasonic D5 デッキを使用してキャプチャー/テープへ書き出しを行う際は、AJA Premeire Pro 
Device Control プラグインのタイムコードソース設定を LTC+VITC にしなければなりません。  

Avid Open I/O Plug-ins 
• AJA デバイスをオーディオのみキャプチャーするために“キャプチャーツール”で使用するためには、
“キャプチャーツール”で AJA デバイスを選択している必要があります。 

1. キャプチャーツールを開く 
2. AJA KONA あるいは AJA Io などのビデオ入力およびオーディオ入力を選択 
3. オーディオのみのキャプチャーを開始 

• AJA デバイスを”オーディオパンチインツール”で使用するためには、”キャプチャーツール”で AJA 
デバイスを選択している必要があります。 

1. キャプチャーツールを開く 
2. AJA KONA あるいは AJA Io などのビデオ入力を選択 
3. キャプチャーツールを閉じる 
4. オーディオパンチインツールを開く 
5. AJA KONA あるいは AJA Io などの入力デバイスを選択 

• Open I/O Plug-ins がインストールされている場合、タイムラインの不特定なループは、Avid アプ
リケーションの再生停止や、エラーメッセージの原因となる可能性があります。 

• KONA 3 または KONA 3G でデュアルリンク RGB ソースをキャプチャーする場合、E/E されるデュ
アル SDI 出力は正しくない可能性があります。 

• AJA ハードウェアはコントロールパネルを使用してゲンロックを ’Input’ と ‘Reference' で切り換
えることができますが、Media Composer でキャプチャーを行う場合、この選択によってバッチキャ
プチャーが正しく行えない場合があります。この問題を回避するにはゲンロックを ”Input” に設定
します。 

• アナログビデオ入力は Media Composer のキャプチャーツールに正しく検出されない場合があり
ます。 この問題は Media Composer の起動時にソースビデオを再生しておくことで回避できます。

 AJA TV 
• QuickTime コンポーネントへの対応廃止に伴い、AJA TV は今後正しく動作しない可能性がありま
す。

�  | AJA KONA, Io and T-TAP Software Installer - macOS v14.3      　　　          www.aja-jp.com21

http://www.aja.com

